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เอกสารประกอบการเรียน  รายวิชาคอมพิวเตอร์กราฟิก (ง32241)  
ชั้นมัธยมศึกษาปีที่ 5  สาระการเรียนรู้เพ่ิมเติม   

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี (เทคโนโลยี)  
หน่วยการเรียนรู้ที่ 2 การใช้งานโปรแกรม Adobe Photoshop เบื้องต้น  

 เล่มที่ 6      เรื่อง การสร้างข้อความ 
 
 
 

 
 
 
 
 

นางสาวเบญญาภา  ตนกลาย 
ต าแหน่ง  ครู  วิทยฐานะ ครูช านาญการ 

โรงเรียนไทรแก้ววิทยา  อ าเภอปราสาท  จังหวัดสุรินทร์ 
สังกัด  ส านักงานเขตพื้นที่การศึกษามัธยมศึกษา เขต 33 

ส านักงานคณะกรรมการการศึกษาขั้นพื้นฐาน  กระทรวงศึกษาธิการ 
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 เอกสารประกอบการเรียน  รายวิชาคอมพิวเตอร์กราฟิก (ง32241) ชั้นมัธยมศึกษาปีที่ 5  
สาระการเรียนรู้เพ่ิมเติม  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี (เทคโนโลยี) หน่วยการเรียนรู้ที่  2  
การใช้งานโปรแกรม Adobe Photoshop เบื้องต้น เล่มที่  6  การสร้างข้อความ  ชุดนี้  จัดท าขึ้น
เพ่ือเป็นเอกสารประกอบการเรียน รายวิชาคอมพิวเตอร์กราฟิก รหัส ง32241  ชั้นมัธยมศึกษาปีที่ 5  
สาระการเรียนรู้เพ่ิมเติม  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี (เทคโนโลยี)  โดยเน้น
ผู้เรียนเป็นส าคัญให้สามารถพัฒนาความรู้ ความเข้าใจ เกี่ยวกับการใช้งานโปรแกรม Adobe  Photoshop  เบื้องต้น  
ทั้งนี้ได้จัดเนื้อหาให้เข้าใจง่ายและชัดเจนมากยิ่งขึ้น นักเรียนสามารถน าไปศึกษาด้วยตนเองและ
ประยุกต์ใช้ในชีวิตประจ าวันได้  เอกสารประกอบการเรียน  เรื่อง  การใช้งานโปรแกรม  Adobe  Photoshop  
เบื้องต้น   มีทั้งหมด 7 เล่ม เนื้อหาในแต่ละเล่มมีความต่อเนื่องกัน  ดังนั้นนักเรียนจึงควรศึกษาตาม
ขั้นตอนทีละเล่ม 

 เอกสารประกอบการเรียน  เล่มที่  6  การสร้างข้อความ  นักเรียนควรอ่านค าแนะน าการ
ใช้ให้เข้าใจก่อนเป็นล าดับแรกและปฏิบัติตามด้วยความซื่อสัตย์ เพื่อเป็นผลดีในการสร้างองค์ความรู้
ที่ยั่งยืน 

 
 

        เบญญาภา  ตนกลาย 
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 เอกสารประกอบการเรียน  รายวิชาคอมพิวเตอร์กราฟิก (ง32241) ชั้นมัธยมศึกษาปีที่ 5  
สาระการเรียนรู้ เ พ่ิมเติม  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี (เทคโนโลยี )                
หน่วยการเรียนรู้ที่  2  การใช้งานโปรแกรม Adobe Photoshop เบื้องต้น  ได้จัดท า จ านวน  7  เล่ม  
ประกอบด้วย 

 เล่มที่  1  รู้จักกับโปรแกรม Adobe  Photoshop  
 เล่มที่  2  ส่วนประกอบของโปรแกรม Adobe  Photoshop  
 เล่มที่  3  การจัดการไฟล์งาน 
 เล่มที่  4  การสร้าง Selection 
 เล่มที่  5  การปรับมุมมองรูปภาพเบื้องต้น  
 เล่มที่  6  การสร้างข้อความ 
 เล่มที่  7  การใช้เครื่องมือวาดภาพ 
 เอกสารประกอบการเรียน  เล่มที่  6  การสร้างข้อความ  มีเนื้อหาเกี่ยวกับการใช้งาน

โปรแกรม Adobe  Photoshop CS3  เป็นเอกสารประกอบการเรียนที่มีการจัดกิจกรรมการเรียนรู้ที่
แปลกใหม่  นักเรียนจะได้รับประสบการณ์จากการเรียนรู้เกี่ยวกับการใช้โปรแกรมกราฟิก  สามารถ
เรียนรู้ด้วยความสนุกสนาน  ได้รับความรู้  ความเพลิดเพลิน โดยยึดหลักนักเรียนทุกคนสามารถเรียนรู้
และพัฒนาตนเองได้  รวมทั้งยึดหลักผู้เรียนเป็นส าคัญ  สอดคล้องกับหลักสูตรแกนกลางการศึกษา       
ขั้นพ้ืนฐาน  พุทธศักราช  2551  นักเรียนสามารถน าความรู้และทักษะจากการท ากิจกรรมการเรียนรู้
ไปประยุกต์ใช้ในชีวิตประจ าวันและศึกษาหาความรู้ต่อในอนาคต 
 

        เบญญาภา  ตนกลาย 
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ค าแนะน าส าหรับคร ู
 
 

 เอกสารประกอบการเรียน  รายวิชาคอมพิวเตอร์กราฟิก (ง32241) ชั้นมัธยมศึกษาปีที่ 5  
สาระการเรียนรู้เพ่ิมเติม  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี (เทคโนโลยี) หน่วยการ
เรียนรู้ที่ 2 การใช้งานโปรแกรม Adobe Photoshop เบื้องต้น  เล่มที่  6  การสร้างข้อความ  เล่มนี้                  
ใช้ประกอบการจัดกิจกรรมการเรียนรู้นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนไทรแก้ววิทยา  โดยมี
ขั้นตอนการจัดกิจกรรมการเรียนการรู้  ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1. ครูแจกเอกสารประกอบการเรียน เล่มที่  6  การสร้างข้อความ  ให้นักเรียน 
2. ครูชี้แจงการใช้เอกสารประกอบการเรียนให้นักเรียนทราบก่อนลงมือปฏิบัติ 
3. ครูให้นักเรียนศึกษาเอกสารประกอบการเรียน เล่มที่  6  การสร้างข้อความ

โปรแกรม Adobe  Photoshop  และท าใบงาน เพ่ือให้นักเรียนได้ทบทวนและเกิดความรู้
ความเข้าใจอย่างถูกต้อง 

4. ครูสังเกตพฤติกรรมการท างาน และบันทึกผลลงในแบบบันทึกพฤติกรรมการ
ท างาน 

5. ครูตรวจผลงานและบันทึกคะแนนลงในแบบเก็บคะแนน เล่มที่  6  การสร้างข้อความ 
6. ครูให้นักเรียนท าแบบทดสอบหลังเรียนเพ่ือตรวจสอบความรู ้ความเข้าใจหลังเรียน 
7. ครูแจ้งคะแนนให้นักเรียนทราบและชมเชยนักเรียนพร้อมให้ค าแนะน าเพ่ิมเติม 
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แนะน าส าหรับนักเรียน 
 

เพ่ือให้การศึกษาเอกสารประกอบการเรียน  รายวิชาคอมพิวเตอร์กราฟิก (ง32241)       
ชั้นมัธยมศึกษาปีที่ 5  สาระการเรียนรู้เพ่ิมเติม  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี 
(เทคโนโลยี) หน่วยการเรียนรู้ที่ 2 การใช้งานโปรแกรม Adobe Photoshop เบื้องต้น  เล่มที่  6  
การสร้างข้อความ  ได้บรรลุตามจุดประสงค์การเรียนรู้ นักเรียนควรปฏิบัติตามข้ันตอนต่อไปนี้ 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

อุปกรณ์ 
 

 1. เอกสารประกอบการเรียน เล่มที่  6  การสร้างข้อความ 
 2. เครื่องคอมพิวเตอร์เชื่อมต่อระบบเครือข่ายพร้อมอุปกรณ์ 
 3. เครื่องฉายโปรเจคเตอร์ 
 4. โปรแกรม Adobe Photoshop CS3 Extended  
 
 
 

1.  ศึกษาจุดประสงค์การเรียนรู้ เพ่ือให้ทราบว่าเมื่อจบแต่ละเรื่องแล้ว 
นักเรียนสามารถเรียนรู้อะไรบ้าง 

2.  ศึกษาเอกสารและท ากิจกรรมตามที่ก าหนดไว้เพ่ือเป็นการทบทวนให้มี
ความรู้ความเข้าใจเนื้อหายิ่งขึ้น 

3.  ท าแบบทดสอบหลังเรียน เพ่ือวัดความรู้ความเข้าใจอีกครั้งหนึ่งแล้ว
ตรวจค าตอบด้วยตนเอง 

4.  นักเรียนต้องมีความซื่อสัตย์ต่อตนเอง โดยไม่เปิดดูเฉลยก่อน 
  5.  ถ้านักเรียนต้องการเนื้อหาเพ่ิมเติมจากเอกสารประกอบการเรียนทั้งหมด
สามารถค้นคว้าได้จากเอกสารอ้างอิงที่ปรากฏในหน้าบรรณานุกรม 

6.  ให้นักเรียนใช้เวลาในการศึกษาเอกสารประกอบการเรียน  70  นาที 
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ผลการเรียนรู ้
 
 
 
 สามารถอธิบายและ ใช้งานเครื่องมือสร้างข้อความ   
 
     
 

จุดประสงค์การเรียนรู ้
 
 
 
 10. สามารถอธิบายและสร้างตัวอักษรได้ 
 
 
 
 
 
 
 
 
 
 
 

รู้เป้าหมายแล้วไปหาความรู้

กันเลยนะคะเพื่อนๆ 
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ใบความรู้ 
 

 
เร่ือง  การสร้างข้อความ 

 

การใช้เครื่องมือ  Type  สร้างตัวอักษร   
 

 ทิพาภรณ์  ประดู่  และคณะ  ( 2555  :  85 )  ได้กล่าวถึง  การใช้เครื่องมือ Type Tool           
ในโปรแกรม Adobe Photoshop CS3 ซึ่งเมื่อคลิกค้างที่เครื่องมือนี้ จะได้เครื่องมือย่อยด้วยกัน 4 ตัว คือ 
  - Horizontal Type Tool การพิมพ์ตัวอักษรในแนวนอน 
  - Vertical Type Tool การพิมพ์ตัวอักษรในแนวตั้ง 
  - Horizontal Type Mask Tool การพิมพ์ตัวอักษรเพ่ือเป็น Selection ในการท า 
Mask หรือน าไปเป็นเส้น paths เพ่ือการใช้งานต่อไป เป็นการพิมพ์ตัวอักษรในแนวนอน 
  - Vertical Type Mask Tool เช่นเดียวกับเครื่องมือ Horizontal Type Mask Tool 
แต่เป็นการใช้งานในแนวตั้ง     
  
 
 
 
 
 

กลุ่มเครื่องมือ  Text 
 

   ออบชั่นบาร์ของเครื่องมือ Type Tool 
 
 
 
 
 
 
 

แสดงเครื่องมือท่ีเลือก 

ปรับอักษรให้เป็นแบบ
แนวตั้งหรือแนวนอน 

ก าหนดรูปแบบตัวอักษร 

แสดงเครื่องมือท่ีเลือก 

ก าหนดขนาดตัวอักษร 
ก าหนดรูปแบบ 
การจัดข้อความ 

ก าหนดความเรียบของ
ตัวอักษร 

ก าหนดส ี

รูปแบบข้อความ 

เปิดพาเล็ต 
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   พาเล็ต   Character 
 
 
 
 
 
 
 
 
 
 
 
 1.  การใช้  Horizontal Type Tool  มีข้ันตอนดังนี้ 
  1.1  สร้างไฟล์งานใหม่โดยคลิกท่ีเมนู  File -> New  ระบุขนาดพื้นที่ท างานตาม
ต้องการ  จากนั้นคลิก  OK 
  1.2  คลิกท่ีเครื่องมือ  Horizontal Type Tool  จากนั้นน าไปคลิกบนพื้นที่การ
ท างานแล้วพิมพ์ข้อความที่ต้องการลงไป 
 
 
 
 
 
 
 
 
 
  1.3  ปรับเปลี่ยนรูปแบบข้อความท่ีออปชั่นบาร์ตามต้องการ 
 
 
 
 

ก าหนดภาษา 

ก าหนดลักษณะตัวอักษร 

ก าหนดตัวอักษรเป็นแบบยก/ห้อย 
ปรับความสูงของตัวอักษร 

ก าหนดระยะห่างระหว่างตัวอักษร 
ก าหนดขนาดตัวอักษร 

ก าหนดรูปแบบตัวอักษร ก าหนดสไตล์อักษร 

ก าหนดระยะห่างระหว่างบรรทัด 
ก าหนดระยะห่างโดยรวม 

ปรับความกว้างของตัวอักษร 
ก าหนดสตีัวอักษร 

ก าหนดความเรียบของตัวอักษร 
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 2.  การใช้  Vertical Type Tool  มีข้ันตอนดังนี้ 
  2.1  สร้างไฟล์งานใหม่โดยคลิกท่ีเมนู  File -> New  ระบุขนาดพื้นที่ท างานตาม
ต้องการ  จากนั้นคลิก  OK 
  2.2  คลิกท่ีเครื่องมือ  Vertical  Type Tool  จากนั้นน าไปคลิกบนพ้ืนที่การท างาน
แล้วพิมพ์ข้อความท่ีต้องการลงไป 
 
 
 
 
 
 
 
 
 
  2.3  ปรับเปลี่ยนรูปแบบข้อความท่ีออปชั่นบาร์  ตามต้องการ 
 
 3.  การใช้  Horizontal Type Mask Tool  มีข้ันตอนดังนี้ 
  3.1  สร้างไฟล์งานใหม่โดยคลิกท่ีเมนู  File -> New  ระบุขนาดพื้นที่ท างานตาม
ต้องการ  จากนั้นคลิก  OK 
  3.2  คลิกท่ีเครื่องมือ  Horizontal Type Mask Tool  จากนั้นน าไปคลิกบนพ้ืนที่การ
ท างานแล้วพิมพ์ข้อความท่ีต้องการลงไป 
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  3.3  กดปุ่ม  Alt  ที่คีย์บอร์ดแล้วคลิกท่ีเครื่องมือ  Move  Tool  เพ่ือคัดลอกข้อความ
จากนั้นคลิกเมาส์ด้านซ้ายค้างไว้ที่ข้อความแล้วลากไปวางบนต าแหน่งที่ต้องการ  หรือ 
  3.4  คลิกที่เมนู  Edit -> Copy  คลิกต าแหน่งที่ต้องการ  จากนั้นคลิกที่เมนู  Edit -> Paste 
  3.5  ตกแต่งข้อความให้ดูโดดเด่นขึ้นโดยใส่สีเส้นให้กับข้อความโดยคลิกที่เมนู  Edit -> Stroke        
จะปรากฏหน้าต่างดังรูป 
 
 
 
 
 
 
 
 
 
 
 
  3.6  คลิกท่ีปุ่ม  OK  จากนั้นกดปุ่ม  Ctrl + D  เพ่ือยกเลิกการ  Selection  ข้อความจะ
ได้ผลลัพธ์ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 

ความโปร่งแสง 

สีเส้นคลิกท่ีสจีะปรากฏกลุม่

สีให้คลิกเลือกสตีามต้องการ 

ขนาดของเส้น 

โมเดลข้อความ 

ต าแหน่งของเส้น 

www.kr
oo

ba
nn

ok
.co

m



 

 
5 

 4.  การใช้  Vertical Type Mask Tool  มีข้ันตอนดังนี้ 
  4.1  สร้างไฟล์งานใหม่โดยคลิกท่ีเมนู  File -> New  ระบุขนาดพ้ืนที่ท างานตามต้องการ  
จากนั้นคลิก  OK 
  4.2  คลิกท่ีเครื่องมือ  Vertical Type Mask Tool  จากนั้นน าไปคลิกบนพื้นที่การ
ท างานแล้วพิมพ์ข้อความท่ีต้องการลงไป 
 
 
 
 
 
 
 
 
 
 
 
  4.3  คลิกท่ีเครื่องมือ  Paint  Bucket  Tool  จากนั้นเทสีลงที่ข้อความโดยการคลิกเมาส์ด้านซ้าย
ที่ข้อความ 
  4.4  กดปุ่ม  Ctrl  + D  เ พ่ือยกเลิกการ  Selection  จะสังเกตได้ว่า
ข้อความที่สร้างขึ้ นจะมีสี เฉพาะเส้นขอบเนื่องจาก  Select ion  เ พ่ือสร้างข้อความ  
Select ion  ในลักษณะเส้นขอบเท่านั้น   
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การตกแต่งข้อความ   
 
 การตกแต่งข้อความให้สวยงามน่าสนใจนั้น  สามารถท าได้หลายวิธี  โดยประยุกต์จากค าสั่งต่าง  ๆ            
ดังตัวอย่างต่อไปนี้ 
 1.  การตกแต่งด้วยโมเดล 
  1.1  เปิดไฟล์รูปภาพที่ต้องการเป็นฉากหลังตัวอักษร 
  1.2  คลิกท่ีเครื่องมือ  Horizontal Type Tool   จากนั้นน าไปคลิกบนพ้ืนที่การท างาน
แล้วพิมพ์ข้อความลงไป  เช่น  ค าว่า  COMPUTER   
 
 
 
 
 
 
 
 
  1.3  คลิกท่ี  Layer  ข้อความ  จากนั้นเลือกโมเดลที่ต้องการ  ในพาเล็ต  Layer  เช่น  
เลือกโมเดล  Color  Burn  ตัวอักษรจะเปลี่ยนเป็นรูปแบบอ่ืน 
  
 
 
 
 
 
 
 
 
 
 
 
 

เปลี่ยนที่น่ี 
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 2.  การตกแต่งด้วย  Blending  Option 
  2.1  คลิกท่ีปุ่ม  Add  a  Layer  Style  ในพาเล็ตเลเยอร์  เลเยอร์  จะปรากฏค าสั่ง
ต่างๆ  ให้คลิกท่ีค าสั่ง  Blending  Options  
 
 
 
 
 
 
 
 
 
 
 
 
  2.2  จะปรากฏหน้าต่าง  Layer  Style  ซึ่งมีรายละเอียดดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ปรับรูปแบบ
ตามต้องการ 

การเตมิลวดลายให้กับวตัถุ 

การเตมิสีให้กับวัตถ ุ

การสร้างขอบแบบฟุ้งกระจาย 

การสร้างเงาแบบตกพื้น 

การท าให้วัตถุนูนขึ้น   
   ด้วยแสงและเงา 

การใส่สเีส้นให้กับวัตถุ 

การเตมิสีแบบไลเ่ฉดสี
ให้กับวัตถ ุ

การสร้างพื้นผิวด้านในของ
วัตถุมีสี่เหลี่ยมเป็นเงา 

การสร้างความฟุ้งกระจาย
ด้านในของวัตถุ 

การสร้างเงาบริเวณพื้นที่
ภายใน 
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  2.3  ปรับแต่งสไตล์ของข้อความตามต้องการ  จากนั้นกดปุ่ม  OK  จะได้ผลลัพธ์ตามที่เลือกไว้ 
 
 
 
 
 
 

ตัวอย่างรูปหลังปรับแต่ง 
 

การสร้างข้อความหลายบรรทัดและการจัดการข้อความ  
 

 การสร้างข้อความแบบหลายบรรทัด  จ าเป็นต้องก าหนดขอบเขตให้กับข้อความก่อน  เพ่ืออ านวย      
ความสะดวกให้ขณะพิมพ์  คือ  เมื่อพิมพ์จบบรรทัดแล้วจะขึ้นบรรทัดใหม่ให้อัตโนมัติ  และจัดการกับข้อความให้ได้
รูปตามต้องการ  ซึ่งมีข้ันตอนดังนี้ 
 1.  สร้างไฟล์ใหม่เพื่อใส่ข้อความแบบหลายบรรทัด 
 2.  คลิกที่เครื่องมือ  Horizontal  Type  Tool  จากนั้นคลิกเมาส์ด้านซ้ายค้างไว้ที่มุมบน
ซ้ายของพ้ืนที่การท างาน  จากนั้นลากเฉียงมาด้านขวาในต าแหน่งจุดสิ้นสุดของพ้ืนที่การท างาน     
เพ่ือก าหนดพ้ืนที่ของข้อความ 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมาส์ด้านซ้ายค้างไว้

ที่สุดเริ่มต้น 

ลากมายังจดุสิ้นสุด

จากนั้นปล่อยเมาส ์
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 3.  คลิกเมาส์ในต าแหน่งที่ต้องการพิมพ์  จากนั้นพิมพ์ข้อความที่ต้องการ 
 
 
 
 
 
 
 
 
 
 
 
 4.  คลิกท่ีพาเลต  Paragraph  ปรับเปลี่ยนรูปแบบตามต้องการ  ซึ่งมีรายละเอียดดังนี้ 
 
 
 
 
 
 
 
 
 
 
 

 
 
 5.  คลิกท่ีเครื่องมือ  Move  Tool  เพ่ือจบการท างาน 
 
 
 
 

อย่าลืมฝึกเพิ่มเติมนะคะ 

เข้าใจแล้วใช่ไหมค่ะ .. 

ไปตอบใบงานกันเลยค่ะ 

เว้นระยะย่อหน้าล่าง 

เยื้องหลังทั้งย่อหน้า 

จัดข้อความซ้ายขวา
เท่ากันทุกบรรทัด 

จัดข้อความให้ซ้ายขวาเท่ากันแต่บรรทัด
สุดท้ายอยู่ชิดขวา 

บรรทัดสุดท้ายอยู่กึ่งกลาง 

จัดข้อความให้ซ้ายขวาเท่ากัน

แต่บรรทดัสุดท้ายชิดซ้าย 
จัดข้อความแบบชิดขวา 

จัดข้อความแบบกึ่งกลาง 

จัดข้อความแบบชิดซ้าย 

เยื้องหน้าท้ังย่อหน้า 

เยื้องหน้าบรรทดัแรก 

เว้นระยะย่อหน้าบน 

ก าหนดการตัดค า 
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ใบงาน 
 

เรื่อง การสร้างข้อความ   วิชาคอมพิวเตอร์กราฟิก 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  ชั้นมัธยมศึกษาปีท่ี 5 

------------------------------------------------------------------------------------------------------------------ 
ชื่อ สกุล........................................................................................ชั้น ..........................เลขที่ ............ 
 
ค าชี้แจง  ให้นักเรียนตอบค าถามต่อไปนี้ 
1.  กลุ่มเครื่องมือ  Type  Tool  มีก่ีแบบอะไรบ้าง 
............................................................................................................................. ................................... 
............................................................................................... ................................................................. 
............................................................................................................................. ................................... 
.......................................................................................................................................................... ...... 
............................................................................................................................ .................................... 
............................................................................................................................. ................................... 
................................................................................................................................................................  
............................................................................................................................. ................................... 
............................................................................................................................. ................................... 
2.  บอกส่วนประกอบของพาเล็ต  Character  ดังต่อไปนี้ 
 
 
 
 
 
 
 
 
 
 
 
 

……………………………… 

……………………………… 
……………………………… 

……………………………… 
……………………………… 

……………………………… 

……………………………… 
……………………………… 

……………………………… 

……………………………… 
……………………………… 

……………………………… 

……………………………… 
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3.  จงบอกข้ันตอนการใส่สีเส้นให้กับตัวอักษร  พร้อมทั้งบอกส่วนประกอบหน้าต่าง  Stroke  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  บอกส่วนประกอบของพาเล็ต  Paragraph  ดังต่อไปนี้ 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… ………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… ………………………………

……………………………… ………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 

………………………………

……………………………… 
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5.  บอกความหมายของสไตล์  ดังต่อไปนี้ 
Drop  Shadow  :  ................................................................ ............................................................. 
Inner  Shadow  :  ................................................................................................................ .............. 
Outer  Glow  :  ............................................................................................................................. ..... 
Inner  Glow  :  .............................................................................. ...................................................... 
Bevel  and  Emboss  :  ...................................................................................................................  
Satin  :  ...............................................................................................................................................  
Color  Overlay  :  ............................................................................................................................. . 
Gradient  Overlay  :  ........................................................................................................................  
Pattern  Overlay  :  .............................................................................................................. ............ 
Stroke  :  ............................................................................................................................. ................ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เข้าใจแล้วเรามาฝึกทักษะกันหนอ่ยนะคะ 
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กิจกรรม 
 

เรื่อง การสร้างข้อความ   วิชาคอมพิวเตอร์กราฟิก 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  ชั้นมัธยมศึกษาปีท่ี 5 

------------------------------------------------------------------------------------------------ 

ค าช้ีแจง  ให้นักเรียนออกแบบการ์ดอวยพรเนื่องในโอกาสต่างๆ  ขนาด 20 ซม. (20X20)      
  จ านวน  1  ใบ  โดยมีองค์ประกอบดังนี้   
  1.  ข้อความ   
  2.  รูปภาพ   
  3.  ตกแต่งให้สวยงาม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

เพื่อนๆ พร้อมแล้วมาวัดความรู้หลังเรียนกันค่ะ 
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แบบทดสอบหลงัเรยีน 
 

เรื่อง การสร้างข้อความ   วิชาคอมพิวเตอร์กราฟิก 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  ชั้นมัธยมศึกษาปีท่ี 5 

------------------------------------------------------------------------------------------------ 
ค าชี้แจง : 1. แบบทดสอบเป็นแบบปรนัย  แบบ  5 ตัวเลือก  จ านวน  10  ข้อ  เวลา  10  นาท ี
  2. ให้นักเรียนเลือกค าตอบที่ถูกตองที่สุดเพียงค าตอบเดียวแลวท าเครื่องหมาย X ลงใน 
      กระดาษค าตอบที่ครูแจกให้ 
 
1.  การใส่สไตล์แบบสร้างขอบวัตถุให้ฟุ้งกระจายคือข้อใด 
 1.  Drop  Shadow 

 2.  Inner  Shadow 
 3.  Outer  Glow 
 4.  Inner  Glow 
 5.  Outer  Glow 

 
2. ถ้าต้องการพิมพ์ตัวอักษรในแนวนอน  ต้องใช้เครื่องมือ  Type  Tool  ข้อใด 
 1.  Horizontal Type Tool 

 2.  Vertical Type Tool 
 3.  Horizontal Type Mask Tool 
 4.  Vertical Type Mask Tool 
 5.  Type Layer  Mask Tool 

 
3. สัญลักษณ์   (Create  warped  text)  ในออปชั่นบาร์ของ  Type  Tool  มีหน้าที่อย่างไร   
 1.  ก าหนดรูปแบบอักษร 

 2.  ก าหนดความเรียบของข้อความ 
 3.  ปรับอักษรให้เป็นแบบแนวนอนหรือแนวตั้ง 
 4.  ก าหนดขนาดตัวอักษร 
 5.  รูปแบบข้อความ 
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4. สัญลักษณ์   (Horizontally  Scale)  ในพาเล็ต  Character  มีหน้าที่อย่างไร 
 1.  ปรับความสูงของตัวอักษร 

 2.  ปรับความกว้างของตัวอักษร 
 3.  ก าหนดลักษณะตัวอักษร 
 4.  ก าหนดระยะห่างโดยรวม 
 5.  ก าหนดระยะห่างตัวอักษร 
 

5.  ข้อใดเป็นเครื่องมือเยื้องหน้าทั้งย่อหน้า   
 1.   

 2.  
 3.  
 4.  
 5.  

 
6.  การยกเลิก  Selection  ใช้ปุ่มใดเป็นคีย์ลัด  
 1.  ALT + D 

 2.  Shift + D 
 3.  Ctrl + D 
 4.  Ctrl + U 
 5.  ALT + V 
 

7.  สัญลักษณ์    ในพาเล็ต  Character  มีหน้าที่อย่างไร 
 1.  ก าหนดรูปแบบตัวอักษร 

 2.  ก าหนดสไตล์ตัวอักษร 
 3.  ก าหนดระยะห่างระหว่างบรรทัด 
 4.  ก าหนดความเรียบของตัวอักษร 
 5.  ก าหนดอักษรเป็นแบบยกและห้อย 
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8.  ข้อใดเป็นเครื่องมือจัดข้อความชิดขวา   
 1.  

 2.  
 3.  
 4.  
 5.  

 
9. การเลือกค าสั่ง  Location  ใน  Stroke  จะแสดงผลลัพธ์อย่างไร 
 1.  ต าแหน่งของเส้นอยู่ด้านนอก 

 2.  ต าแหน่งของเส้นอยู่ด้านใน 
 3.  ต าแหน่งของเส้นอยู่ตรงกลาง 
 4.  ต าแหน่งของข้อความอยู่ด้านนอก 
 5.  ต าแหน่งของข้อความอยู่ด้านใน 

 
10. ข้อใดเป็นตัวเลือกการใส่สไตล์แบบสร้างเงาให้ตกพ้ืน 
 1.  Drop  Shadow 

 2.  Inner  Shadow 
 3.  Outer  Glow 
 4.  Inner  Glow 
 5.  Satin 

 
 
 
 

ไปดูเฉลยกันเลยค่ะ เพื่อนๆ 

เราต้องซื่อสัตย์ต่อตัวเองนะคะ 
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“วิธีใช้โปรแกรมโฟโต้ช็อปพื้นฐาน Adobe Photoshop”.   (2554).  [ออนไลน์].  เข้าถึงได้จาก    

http://11he.blogspot.com/2012/08/adobe-photoshop.html 
 “รู้จักโปรแกรม Photoshop cs3”  (2555).  [ออนไลน์].  เข้าถึงได้จาก   

http://www.edu-mine.com/photoshop/lesson1_IntroPhotoshop.html 
“เอกสารประกอบการอบรมเทคนิคการสร้างและตกแต่งภาพด้วย Adobe Photoshop CS3”   

(2555).  [ออนไลน์].  เข้าถึงได้จาก  http://forstd.net/doc_upload/photoshopCS3.pdf 
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ภาคผนวก 
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เฉลยใบงาน 
 

เรื่อง การสร้างข้อความ   วิชาคอมพิวเตอร์กราฟิก 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  ชั้นมัธยมศึกษาปีท่ี 5 

 
1.  กลุ่มเครื่องมือ  Type  Tool  มีก่ีแบบอะไรบ้าง 
 เครื่องมือ Type Tool ในโปรแกรม Adobe  Photoshop  CS3  มีเครื่องมือย่อย 4 ตัว 
คือ 
 1.  Horizontal Type Tool การพิมพ์ตัวอักษรในแนวนอน 
 2.  Vertical Type Tool การพิมพ์ตัวอักษรในแนวตั้ง 
 3.  Horizontal Type Mask Tool การพิมพ์ตัวอักษรเพ่ือเป็น Selection ในการทํา Mask 
หรือนําไปเป็นเส้น paths เพ่ือการใช้งานต่อไป เป็นการพิมพ์ตัวอักษรในแนวนอน 
 4.  Vertical Type Mask Tool เช่นเดียวกับเครื่องมือ Horizontal Type Mask Tool แต่
เป็นการใช้งานในแนวตั้ง     
 
2.  บอกส่วนประกอบของพาเล็ต  Character  ดังต่อไปนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

กําหนดภาษา 

กําหนดลักษณะตัวอักษร 

กําหนดตัวอักษรเป็นแบบยก/ห้อย 
ปรับความสูงของตัวอักษร 

กําหนดระยะห่างระหว่างตัวอักษร 

กําหนดขนาดตัวอักษร 
กําหนดรูปแบบตัวอักษร กําหนดสไตล์อักษร 

กําหนดระยะห่างระหว่างบรรทัด 
กําหนดระยะห่างโดยรวม 

ปรับความกว้างของตัวอักษร 
กําหนดสตีัวอักษร 

กําหนดความเรียบของตัวอักษร 
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3.  จงบอกข้ันตอนการใส่สีเส้นให้กับตัวอักษร  พร้อมทั้งบอกส่วนประกอบหน้าต่าง  Stroke  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
4.  บอกส่วนประกอบของพาเล็ต  Paragraph  ดังต่อไปนี้ 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

เว้นระยะย่อหน้าล่าง 

เยื้องหลังทั้งย่อหน้า 

จัดข้อความซ้ายขวา
เท่ากันทุกบรรทัด 

จัดข้อความให้ซ้ายขวาเท่ากันแต่บรรทัด
สุดท้ายอยู่ชิดขวา 

บรรทัดสุดท้ายอยู่กึ่งกลาง จัดข้อความแบบชิดขวา 

จัดข้อความแบบกึ่งกลาง 

จัดข้อความแบบชิดซ้าย 

เยื้องหน้าท้ังย่อหน้า 

เยื้องหน้าบรรทดัแรก 

เว้นระยะย่อหน้าบน 

กําหนดการตัดคํา 

ความโปร่งแสง 

สีเส้นคลิกท่ีสจีะปรากฏกลุม่

สีให้คลิกเลือกสตีามต้องการ 

ขนาดของเส้น 

โมเดลข้อความ 

ตําแหน่งของเส้น 

จัดข้อความให้ซ้ายขวาเท่ากัน

แต่บรรทดัสุดท้ายชิดซ้าย 
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5.  บอกความหมายของไตล์  ดังต่อไปนี้ 
 Drop  Shadow  :  การสร้างเงาแบบตกพ้ืน 
 Inner  Shadow  :  การสร้างเงาบริเวณพ้ืนที่ภายใน 
 Outer  Glow  :  การสร้างขอบแบบฟุ้งกระจาย 
 Inner  Glow  :  การสร้างความฟุ้งกระจายด้านในของวัตถุ 
 Bevel  and  Emboss  :  การทําให้วัตถุนูนขึ้นด้วยแสงและเงา 
 Satin  :  การสร้างพ้ืนผิวด้านในของวัตถุมีสี่เหลี่ยมเป็นเงา 
 Color  Overlay  :  การเติมสีให้กับวัตถุ 
 Gradient  Overlay  :  การเติมสีแบบไล่เฉดสีให้กับวัตถุ 
 Pattern  Overlay  : การเติมลวดลายให้กับวัตถุ 
 Stroke  :  การใส่สีเส้นให้กับวัตถุ 
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เฉลยข้อสอบหลังเรียน  เร่ือง  การสร้างข้อความ 
 
 

ข้อ 
ตัวเลือก 

1 2 3 4 5 
1 X     
2     X 
3   X   
4   X   
5    X  
6 X     
7  X    
8 X     
9 X     
10   X   
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มุ่งมั่นวิชาการ รักในงานสอน 
อาทรลูกศิษย ์ คิดในทางดี 
มีคุณธรรม  ชี้น าสังคม 
อบรมจิตใจ ใฝ่ความก้าวหน้า 
วาจางดงาม รักความเป็นไทย 
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